
shortcuts are shown in brackets and the ‘+’ symbol 
means to press down the first key, hold it and then also 
press the next key.

Basics in Microsoft Word

The importance of a writer learning to use Microsoft 
Word is just like an electrician becoming intimately 
familiar with the way a house is wired, using a megger, 
power tools, turbo torch and so on.  As with most things 
on the computer, there is often ‘more than one way to 
skin a cat’.  What follows are some of the best ways for 
a writer to use Microsoft Word.  For example, instead of 
manually typing in your page numbers and lining them 
up and having to re-do them every time you change 
enough words to shift a page down, simply 03  ‘View’ 
 ‘Header and footer’  ‘Insert Page Number’ (icon 
of a page with a hash on it) or 07  ‘Insert’  ‘Page 
Number’ and Word will take care of it for you.  

If you discover you’ve been spelling a certain place-
name incorrectly throughout your article or story, 
instead of manually scanning through and changing 
every occurrence, use the find and replace tool: 03  
‘Edit’  ‘Find’ (CTRL+F) ... , 07  ‘Home’  ‘Replace’.  
Don’t be afraid of the power of this tool, but do think 
about whether the word you’re replacing could be 
an embedded part of other words.  Click on ‘More’ 
and read all the settings and options.  Ticking ‘whole 
words only’ will protect other words that contain the 
word you’re replacing, but it will mean that pluralised 
versions of it, 
etc., will not 
get changed 
and you’ll have 
to think of 
these and do a 
second ‘Find/
Replace’.  If in 
doubt, simply 
make a backup 
copy of your 
document 
before doing 
the Find/Replace.  Or you can always use 03  ‘Edit’ 
 ‘Undo’, 07  left-pointing arrow in the top left 
corner (see image), to undo a mistake you’ve just made 
(CTRL+Z). 
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If you want your manuscript to be taken seriously by 
professionals in the publishing industry, then it pays 
to get on top of some of the basic technology being 
used.  There are a variety of word processing programs 
available on computers including Microsoft Word, Open 
Office and Star Office (PC & Mac);  iWork Pages, Apple 
Works and TextEdit (Mac).  Because Microsoft Word 
has set the benchmark on both PC and Mac and tends 
to be the most common, with similar features in other 
software, this article focuses on the use of MS Word.  

Learning how to format manuscripts properly in Word 
and making them typography-friendly may enhance 
your chances of being published.  Whilst magazine 
editors and publishers are not necessarily looking for 
someone who knows how to use tabulation, indentation 
and symbols properly in Word, doing so will make 
your writing much easier for them to work with.  
This ultimately makes your work more practical and 
professional.  

Using the reviewing features in Word and mastering 
how to name your files properly in your operating 
system could save hours of work and prevent an 
organisational-meltdown, if, for example, you forget 
which version of your document is the most recent.  

To some, this advice may seem very basic, but I am 
frequently surprised by the lack of basic computer-
skills, even in adults who use them every day of their 
lives.  Like most things, if we have found a way of doing 
something that seems to work, we often don’t look 
any further to see if there is a better and/or quicker 

way.  With the release 
of Microsoft Office 
2007, it is no longer 
possible to give specific 
instructions that would 
apply to both old and 
new versions of Word, 
so I’ve written ‘03’ in 
front of the instructions 

for Word 2003 and ‘07’ for the new.  The arrow symbol 
‘’ is sometimes used instead of ‘go to the following 
menu/drop-down list’ or ‘then click’ etc.  A bold ellipsis 
(…) indicates I haven’t finished giving instructions 
for that version and to read on to the end where the 
instructions are the same for both versions.  Keyboard 

Word processing  
for writers

“As with most things 
on the computer, there 
is often ‘more than one 
way to skin a cat’.”

Clockwise from left: The new Microsoft Office 
Button, Save icon, Undo icon, Re-do icon, 
Quick Access Toolbar, Insert menu, Home 
menu (Word 2007)



To determine the number of words in your document 
03  ‘Tools’  ‘Word Count’ (ALT+T+W), 07 just look in 
the lower left corner—the word count is always there.  
You can also view the number of words in a selection 
(click and drag the paragraph or line then do the above, 
or CTRL+click and drag to select paragraphs or lines that 
aren’t next to each other).  The CTRL+click feature is 
also useful when you want to apply certain formatting 
to several elements on the page that aren’t side by side.

Formatting in Microsoft Word

Do not use spaces or returns to format.  Can’t get your 
heading or list where you want it?  Using spaces and 
other incorrect formatting is the bane of a typographer’s 
job.  Whilst you have painstakingly inserted enough 
spaces to make your headings or lists line up the way 
you want them to in Word, doing them with spaces 

means they are 
not scalable.  

The second the 
document’s fonts, 
alignment, indents, 
paragraph spacing 
etc. is changed, 
they all go ‘out of 
whack’.  Also, when 
a typographer 
‘places’ your 
document into their 
layout software (eg. 
Adobe InDesign or 

Quark Express), perhaps it is going into columns or a 
narrower page size than your Word document.  If you 
have used spaces to format your document, then all the 
formatting will have to be re-done by the typographer.  

One good way to format paragraphs is with indentation 
(using the little grey arrows on the ruler at the top of 
the screen—if it is not visible then 03/07  ‘View’  
tick ‘Ruler’).  Move the little arrow at the top to indent 
the first line only, move the bottom one (which will also 
move the top one) to indent entire paragraphs, eg. for 
large citations.  If you want a hanging paragraph, first 
indent the entire paragraph, then move the top arrow 
back, which affects only the first line.  Use consistent 
indents throughout your document.  Do not use both 
block paragraphs and indented paragraphs in one 
document; rather use one or the other (this article uses 
block paragraphs).  

When considering whether a citation is big enough to 
warrant being indented, make sure you read samples 
from or, better yet, the style guide for, the publisher 
or magazine you are writing for.  Some magazines, for 
example, want any quotes that are more than three or 
four lines indented so that they stand out as a quote.  
Bear in mind that three or four lines in your Word 
document are probably more like 6 or 7 in a novel-sized 
book or even more in a magazine layout with columns.  
It will not be possible for you to predict exactly how 
many citations the typographer will want indented 
(sometimes this depends on how well the article is 

fitting on the allotted pages), but you can get close.

Traditional publishers (eg. of books) prefer to receive 
hard-copy manuscripts that are double-spaced with 
‘generous’ margins around the edges in case they want 
to write on it.  Keep your ‘master’ document in normal, 
single-spacing so that you can visualise, as you’re 
writing, how it will look.  When sending it to a publisher, 
save a new copy of it specifically for that publisher and 
apply the double-spacing as follows: 03  ‘Format’  
‘Paragraph’ … ,  07  ‘Page Layout’  In the ‘Paragraph’ 
section, click the little arrow, in the lower-left corner, to 
show the ‘Paragraph’ dialog box  03/07 under ‘Line 
Spacing’ tick ‘Double’.  

For lists, use the numbered or bulleted list feature in 
Word.  Just type an asterisk and some words, press 
enter and Word will ‘autoformat’ it for you.  While 
it may seem frustrating at first—the way Word will 
‘autoformat’ things you don’t want it to—once you 
are used to it, it is a great time-saver.  If Word has 
‘autoformatted’ something you don’t want it to, just go 
to Undo (CTRL+Z).  This will undo the auto-format not 
the last key-press or mouse-click made by you.

Do not use tabs unless you have to.  In most cases, 
simply using left-, centre- and right-align is sufficient.  
For tables, it is less work to use the table feature in 
Word than to use tabs: 03  ‘Table’  ‘Insert Table’, 
07  ‘Insert’  ‘Table’.  Getting fed up with Word not 
letting you move your table widths the way you want?  
Try selecting the entire table first (click and drag with 
the mouse) then move your mouse over the vertical line 
you’re trying to move until it turns into two little arrows 
with two lines.  If you want to narrow the entire width 
of your table without making the columns uneven, 
just resize, select the whole table, right-click and go to 
‘Distribute Columns Evenly’.  Don’t spend too much time 
on tables as no matter what you do they will probably 
have to be tweaked a fair bit at the layout stage anyway.

Something that drives editors or layout designers 
bonkers is having to re-number references when 
changes are made (if there are any in your article).  If 
using footnotes or endnotes, don’t just type them in 
manually.  Instead, use the ‘referencing’ feature in 
Word.  That way, if you remove one of your references 
from the body of the document, it will automatically re-
order all subsequent references, including the numbers 
in your footnote or endnote list.  If referring to the 
same reference number a second time, be sure to use a 
‘cross-reference’ in Word, which will also stay ‘relative’ if 
you make changes to the order of previous numbers, 03 
‘Insert’‘Reference’‘Cross-reference’, 07 ‘Insert’ 
‘Cross-reference’.

Symbols are another feature that all writers would be 
wise to master in Word.  03/07  ‘Insert’  ‘Symbol’ 
 pick from what’s available in the font of your choice.  
Go to the ‘Special Characters’ tab to find em-dash (—), 
en-dash (–), copyright (©), registered (®) and trademark 
(™) symbols etc.   Em-dash is a dash the width of a 
capital ‘M’ and is usually used to denote a pause in a 

“Whilst you have painstakingly 
inserted enough spaces to 
make your headings or lists 
line up the way you want 
them to in Word, doing them 
with spaces means they are 
not scalable.”



sentence or to break up a heading.  En-dash is a dash 
the width of a capital ‘N’ and usually means ‘to’ or 
‘then’.  Hyphens should only be used for hyphenated 
words (leave the paragraph hyphenation for fitting 
in columns and around pictures to the typographers; 
most will use these sparingly as they tend to interrupt 
reading-flow).  

Find out whether your target-editor or publisher prefers 
spaces on either side of em-dashes or not (usually so 
for Australia, usually not for USA, UK) and adjust your 
manuscript accordingly.  Ensure that when you type a 
quote-mark in Word (‘) it is slanted or curly, not straight.  
If it’s straight, you need to 03  ‘Format’  Auto 
Format  Options  Tick to replace straight quotes 
with smart quotes or 07  Microsoft Office Button 
(top left colourful logo)  Word Options  Proofing  
AutoCorrect Options  Autoformat as you type  Tick 
to replace straight quotes with smart quotes.  Straight 
quotes generally shouldn’t have a place in any published 
work and are even avoided by websites.  In HTML there 
are special ‘entity codes’—like &lsquo; or &rsquo;—to 
ensure that curly quotes are displayed properly in a 
myriad of browsers and email software.  Straight quotes 
are used within the HTML tags as part of that language.  
If your quote marks are not ‘typographer’s (smart/
curly) quotes’ in Word, then most WYSIWYG web-page 
software will not convert them to entity codes.  Using 
these symbols instead of ordinary hyphens, straight 
quotes, and so forth, may reduce the work required 
by your editor or their typographer.  In a busy world, 
editors appreciate working with writers that share their 
attention to detail.

Reviewing tools in Microsoft Word

Ever been to a writers’ group to have your work 
critiqued only to come home with 20 printed copies 
all with copious notations and corrections written all 
over them?  Not many things can be quite as daunting 
as having to go through and analyse the constructive 
(or otherwise) criticism of 20 different people and 
somehow decide which person’s responses to accept 
and which to reject.  Writers’ group critiques can be 
among the most valuable editing you can get for your 
writing.  Nevertheless it can be a discouragement to 
doing further work on your manuscript.  In this day and 
age of electronic communication, where some writers’ 
groups don’t even meet face-to-face, but contact each 
other primarily over the Internet, there are some tools 
you can use to make the proofing and editing workflow 
much smoother.

Instead of printing copies of your manuscript for your 
proof-readers or writing buddies to work on, convince 
them that doing it on the computer will be much easier 
for them and you.  Doing it one at a time, tag-team 
style will also ultimately save time.  To try out the 
reviewing tools in Microsoft Word (tracked changes) for 
yourself, simply 03 go to the ‘Tools’ menu, then turn 
‘Track Changes’ on, 07 go to the ‘Review’ menu and 
turn ‘Track Changes’ on.  Now every edit you make will 
appear in red and formatting changes will be noted on 

the right in ‘comment’ balloons.  If your proof-reader 
wants to make a comment about something for you to 
work on more, they can go to 03 the ‘Insert Comment’ 
icon which looks like a yellow post-it (if this is not 
visible, turn on the ‘Reviewing’ toolbar by going to 
ViewToolbarsReviewing), 07 ‘Review’ menu, then 
‘New Comment’.  When the manuscript comes back to 
you full of lines and red text, don’t be afraid.  All you 
have to do then is right click on each edit and either 
‘Accept’ or ‘Reject’.  Once you’ve read the comments 
and actioned them, just right-click and ‘delete 
comment’.  Alternatively, 03/07 you can click the drop-
down arrow under ‘Accept’ and then ‘Accept all changes 
in document’.       

You can even make your document ready for tracked 
changes before you send it to your proof-reader.  Just 
03  ToolsProtect DocumentTick ‘Allow only this 
type of editing …’ and select ‘Tracked Changes’ from the 
drop-down, 07 go to the ‘Review’ menu and click on 
‘Protect Document’, then under ‘2. Editing restrictions’ 
tick ‘Allow only this type of editing in the document’ and 
select ‘Tracked Changes’ from the drop-down menu, 
then click the ‘Yes, Start Enforcing Protection’ button.  

I recommend not putting in a password, unless your 
proof-reader is likely to turn off tracked changes AND 
you have somewhere to write it down.  For an editor at 
a publishing house or magazine, leave it up to them if 
they wish to use tracked changes.  



Organising Files

This segment will focus on Windows, the operating 
system on most PCs, but you could apply the same 
principles to any operating system.  Windows has 
a handy feature called ‘My Documents’, which is 
a folder Windows and many other programs use 
to save documents, images and music files.  The 
easiest way to get to it is from the desktop.  The ‘real’ 
location is usually in C:\Documents and Settings\[Your 
User Name]\, but you can actually point your ‘My 
Documents’ folder to any folder on your computer (just 
right-click on ‘My Documents’ and then ‘Move’ the 
target folder).  Depending on what else you use your 
computer for, you may find it useful to have a ‘writing’ 
folder so you can keep these files separated from your 
personal or other files.  In the ‘writing’ folder, create 
sub-folders for other categories of writing, eg. poetry, 
articles, novels, novellas, essays etc.—break it down 
however it suits you.  

When it comes to the naming of files, just use the title 
or working title followed by the date in the format 
YYYYMMDD. This will keep all versions of your files in 
actual date order.  While you may just use the one file 
and save over it again and again, if you have a long-term 
project or if you are transferring Word files from your 
laptop to your computer or on a flash drive to other 
people or by email, then having the date in the filename 
can make it faster to determine which file is the most 
recent.

Another way to check the dates of the documents 
you’ve created, in Windows, is to go to the ‘View’ menu, 
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then ‘Details’.   Or right-click on a particular file and go 
to ‘Properties’ (ALT+Enter).  If the ‘Last modified’ date 
is older than the ‘Created date’ then go by that because 
it reflects the last time you actually saved the file in 
Word.  The created date changes when you move a file 
in Windows (see image on previous page).  If you have a 
long-term project like a novel, I would also recommend 
adding the word ‘master’ to your main working file.  

One way to backup your master file(s) is to right-click 
and copy and paste it to a new folder called ‘backups’.  
Then rename the file to replace the word ‘master’ 
with ‘backup’.  The frequency you should backup files 
depends on your own workflow and the length of time 
you’re working on a project.  Try daily, weekly or every 
time you’ve made major changes or spent more than a 
few hours writing or editing your file.  

Actually saving a file as you’re working on it is another 
important backup lesson I learned the hard way.  
Computers do crash and sometimes a power failure or 
PEBKAC is to blame for closing Word without saving 
your work properly (PEBKAC = Problem Exists Between 
Keyboard And Chair  ).  The auto-save feature in 
Word is useful in some of these situations, but I would 
not rely on it alone.  Save every five to ten minutes, or 
every time your fingers pause on the keyboard.  You 
cannot save often enough.  Learn the keyboard shortcut 
(CTRL+S) and use it often!  

Hopefully some of these tips will be useful to both you 
and your proof-readers and editors as you go about your 
‘real’ work which is simply to write.  

For more about Amanda see:

www.specusphere.com/amanda

www.myspace.com/amandagreenslade 
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